
Upcoming Meetings

Here is a list of mini’app’les meetings for August and September, 2008. The information was compiled as this 
newsletter was being assembled and is subject to change. As always, confirm the Special Interest Group (SIG) 
date, time, and location with the cognizant SIG Leader or the mini’app’les web site (http://
www.miniapples.org).

August Calendar

* This SIG is NOT sponsored by mini'app'les; 
the listing is provided as a service to 
members.

 MEETING  LOCATION  LEADER
 Board of Directors  Merriam Park Library, 1831 Marshall Ave, St Paul  Bruce Thompson, 763-546-1088
 FileMaker Pro SIG  Partners, 2250 Terminal Road, Roseville  Steve Wilmes, 651-458-1513
 iWork/AppleWorks
 SIG

 Augsburg Park Library, 7100 Nicollet Ave S,
 Richfield

 John Hunkins Sr, 651-457-8949

 Mac OS X SIG  The Foundation, 615 North 3rd St, Minneapolis  Bob Demeules, 763-559-1124
 Mac Q&A SIG  Merriam Park Library, 1831 Marshall Ave, St Paul  Les Anderson, 651-735-3953
 Macintosh
 Consultants SIG

 Good Day Café, 5410 Wayzata Blvd, Golden Valley  Bob Demeules, 763-559-1124

 Microsoft Word SIG  Edina Executive Plaza, 5200 Willson Rd, Edina  Tom Ostertag, 651-488-9979

 TC Photoshop SIG*  Minneapolis College of Art & Design, Auditorium
 150, 2501 Stevens Ave S, Minneapolis

 Jeff Tranberry, phone number not
 available

 VectorWorks SIG  CJR Office, 4441 Claremore Dr, Edina  Charles Radloff, 952-941-1667

September Calendar

The mini’app’les Newsletter is an independent publication not affiliated, sponsored, or sanctioned by Apple, Inc. or any other 
computer manufacturer. The opinions, statements, positions, and views are those of the author(s) or newsletter staff and are not 
intended to represent the opinions, statements, positions, or views of Apple, Inc. or any other computer manufacturer. Instead of 
placing a trademark symbol at every occurrence of a trade-marked name, we state we are using the names only in an editorial manner,  
to the benefit of the trademark owner, with no intention of infringement of the trademark.
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Monday August 04 7:00 pm  Board of Directors meeting
Tuesday August 05 7:00 pm  Mac OS X SIG

Wednesday August 06 6:30 pm  iWork/AppleWorks SIG
Wednesday August 13 7:00 pm  TC Photoshop SIG*
Wednesday August 13 7:00 pm  VectorWorks SIG

Monday August 18 7:00 pm  Mac Q&A SIG
Thursday August 21 7:00 am  Macintosh Consultants SIG
Thursday August 28 7:00 pm  FileMaker Pro SIG

Tuesday September 02 7:00 pm  Mac OS X SIG
Wednesday September 03 6:30 pm  iWork/AppleWorks SIG
Wednesday September 10 7:00 pm  Microsoft Word SIG
Wednesday September 10 7:00 pm  VectorWorks SIG
Thursday September 18 7:00 am  Macintosh Consultants SIG
Monday September 22 7:00 pm  Mac Q&A SIG
Thursday September 25 7:00 pm  FileMaker Pro SIG



Board of Directors
President Bruce Thompson
 763-546-1088
 bthompson@macconnect.com

Vice President David Peck
 612-423-5711
 beornsthunder@gmail.com

Secretary Harry Lienke
 651-457-6026
 plienke@aol.com

Treasurer Don Walz
 651-426-5602

Membership Director Chuck Hauge
 612-963-5064
 Chaz@CPHSolutions.com

Publications Director HELP NEEDED
 Please let a Board member
 know if you are interested

SIG Director Kevin Strysik
 65l-489-4691
 strysik@mac.com

Director at Large Tom Gates
 612-789-1713
 tgates@isd.net

Membership  Erik Knopp
Coordinator

CHANGE OF ADDRESS
Moving? Going to be away from home and leaving a 
forwarding address with the Post Office? Changing to 
a better email provider? Please send us a Change of 
Address when you are informing others. By using a 
moment of your time, you ensure you receive a 
notice when your club membership is expiring and 
you get your newsletter email notification delivered 
promptly. Change of Address should be sent to the 
club's mailing address (mini’app’les, Attn: 
Membership Director, Box 796, Hopkins MN 55343) 
or to the club’s email address 
(miniapples@mac.com).

Introduction — This is the newsletter of mini’app’les, the 
Minnesota Apple Computer Users’ Group Inc., a Minnesota 
non-profit club. The whole newsletter is copyrighted© by 
mini’app’les. Articles may be reproduced in other non-profit 
User Groups' publications except where specifically 
copyrighted by the author (permission to reproduce these 
articles must be given by the author). Please include the source 
when reprinting.

Questions — Members with technical questions should refer 
to the Members Helping Members section or bring their 
questions to an appropriate SIG meeting. Please direct other 
questions to an appropriate board member. 

Dealers — mini’app’les does not endorse specific dealers. The 
club promotes distribution of information that may help 
members identify best buys and service. The club itself does not 
participate in bulk purchases of media, software, hardware, and 
publications. Members may organize such activities on behalf 
of other members.

Newsletter Contributions — Please send contributions 
directly to our post office box (mini’app’les, PO Box 796, 
Hopkins MN 55343) or email them to miniapples@mac.com.

Deadline for material for the next newsletter is the fifteenth of 
the month. An article will be printed when space permits and, if 
in the opinion of the Newsletter Editor or Publications Director, 
it constitutes material suitable for publication.

Newsletter Staff this month: Harry and Pam Lienke

The layout of this newsletter was done using Apple’s Pages 
word processor.

mini’app’les forums: http://miniapples.7.forumer.com
mini’app’les web site: http://www.miniapples.org
mini’app’les email: miniapples@mac.com

mini’app’les Newsletter
the minnesota apple computer users’ group, inc. August 2008

 Page 2 of 11



TABLE OF CONTENTS

.....................................................................................From the Editor’s Desk — August, 2008 3
........................................................................................................Members Helping Members 4

...........................................................................................iWork/AppleWorks SIG of July, 2008 5
...............................................................................................................Q&A SIG of June, 2008 6

.......................................................................................................................Strong Passwords 7
..........................................................How to Protect Yourself from the New Mac OS X Trojans 9

.........................................................................................Benefits of mini’app’les Membership 10
.............................................................................Membership Application and Renewal Form 11

From the Editor’s Desk — August, 2008

Volunteers Needed

Each of the last two months I asked mini’app’les 
members to help “make the club more enticing to 
Mac users by increasing the number of special 
interest group (SIG) meetings we have available, by 
having more content in the newsletter, and by having 
more volunteers who are Members Helping 
Members.” So far there has been no response; I am 
not aware of anyone offering to help with club 
business. Why is it that folks are not willing to step 
forward and help? In the thirty years this club has 
been in operation (yea verily, mini’app’les is thirty 
years old this year), no SIG leader has been stoned, 
no one who has written an article has been drummed 
out of the club, no one has been laughed at or cursed 
because he/she didn’t know the answer to another 
member’s question. We need someone besides the 
same old group of folks carrying the load; we need to 
have some other folks step forward and help with the 
tasks mentioned above. We need some one to do the 
layout for the newsletter each month. Please step up 
and get the iLife SIG started and the Main Mac SIG 
restarted. Please write a couple of paragraphs and tell 
us about that problem you had and how it was solved 
so we can apply your knowledge to our situations. 
Please volunteer to be a member helping other 
members so we all become more efficient resolving 
problems.

How Are We Doing?

How do you like our new newsletter format? What do 
you like? What should be changed? What should be 
added? Are there particular topics you think should be 
covered? Do you like receiving the newsletter as a 
PDF attachment to an email or do you prefer to get a 
notice that a new news-letter is available and then 
download the newsletter yourself from the web site? 
Should we be adding a Dear Mr. Jobs column to 
answer questions you send via snail mail and email? 
Does anybody read this newsletter? Am I simply 
pouring gold down a rat hole?

Please send your snail mail comments and questions 
to the club’s post office box (mini’app’les, PO Box 
796, Hopkins MN 55343). You should send email to 
the club’s .mac address (miniapples@mac.com). 
C’mon now, let’s pack those mail boxes full.

Hope to see you at a meeting soon.

Harry Lienke
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Members Helping Members
Need Help? Have a question the manual doesn’t answer? Members Helping Members is a group of volunteers 
who have generously agreed to help. They are just a phone call or an email away. Please call only during the 
appropriate times, and only if you are a current mini’app’les member and own the software in question.

.....Apple II / IIGS Software & Hardware 1, 2
......................AppleWorks / ClarisWorks 3, 4

Classic Macs
....................Cross-Platform File Transfer 2, 3

FileMaker Pro
Intel Based Macs
iMacs

.......................................................iPhoto 3
iTunes / iMovie

........................................Mac OS Classic 3
Mac OS X

........................................Microsoft Excel 2, 5, 8
........................................Microsoft Word 2, 8

......................................................MYOB 5
..................................................Networks 7
................................................New Users 1

PhotoShop
............................................QuarkXPress 8

....................................................Quicken 5
...........QuickBooks and QuickBooks Pro 5

.............................................VectorWorks 6

1. Les Anderson 651-735-3953 anderslc@usfamily.net  DEW
2. Tom Ostertag 651-488-9979 tostertag@usfamily.net EW
3. Bruce Thompson 763-546-1088 bthompson@Macconnect.com EW
4. Pam Lienke 651-457-6026 plienke@aol.com DEW
5. Ardie Predweshny 612-978-9774  DEW
6. Charles Radloff 952-941-1667  D
7. Chuck Hauge 612-963-5064 Chaz@CPHSolutions.com D
8. Ron Heck 651-774-9151  DEW

D: Days, generally 9 am to 5 pm
E: Evenings, generally 5 pm to 9 pm
W: Weekends, generally 1 pm to 9 pm

Please call at reasonable hours and ask if it is a convenient time for helping you. By the way, many of these 
volunteers can also be contacted on our forums. We appreciate your cooperation.

mini’app’les needs more volunteers for Members Helping Members — If you are willing to be a 
Members Helping Member volunteer, please send an email message to Chuck Hauge or contact him on our 
forums with your name, telephone number, contact hours, and the software or hardware areas you are willing to 
support.
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iWork/AppleWorks SIG of July, 2008
by Harry Lienke

The meeting started with a short presentation by 
Harry Lienke contrasting the methods used by Word 
and Pages to copy styles. He showed how a Word 
user highlights text whose style is to be copied. The 
Word user then clicks on the paint brush tool to copy 
the style and highlights the text whose style is to be 
changed. The Pages user must decide whether the 
paragraph style or the character style is to be copied; 
he/she then positions the cursor in the paragraph or 
word whose style is to be copied. To copy the style, 
the Pages user selects either Format > Copy 
Paragraph Style or Format > Copy Character Style. 
To transfer the style to a single paragraph or word, the 
Pages user places the cursor in the paragraph or word 
to be changed and selects either Format > Paste 
Character Style or Format > Paste Paragraph Style; to 
transfer the style to multiple paragraphs or multiple 
words, the Pages user highlights the paragraphs or 
words and then selects either Format > Paste 
Character Style or Format > Paste Paragraph Style. 
Note that frequently used formats can be stored on 
and accessed from the Styles Drawer to simplify 
formatting tasks.

Our moderator, Pam Lienke, demonstrated the 
capability of Pages to compile a Table of Contents 
(TOC) and, along the way, demonstrated the use of 
the Styles Drawer. Pam started with a document she 
had created by extracting several screens from a 
birding web site. The first step was inserting a page 
break at the top of the first page to create a new page; 
she inserted a Table of Contents at the top of the new 
page. The TOC was initially blank since the titles, 
headings, and so forth had not yet been designated. 
When Pam established the TOC, the Inspector opened 
up with the Document and TOC buttons selected so 
she could pick the paragraph styles which were to be 
included in the TOC and which selected styles should 
have a page number displayed; in addition to having 
the default Title, Heading, and Sub-heading styles 
included in the TOC, she selected the Caption style to 
appear in the TOC with its page number.

Pam now proceeded to assign paragraph styles to 
appropriate sections of the text; after the Update Now 

button on the Inspector was clicked, the Titles, 
Headings, and so forth which had been selected in the 
text magically appeared in the TOC. In response to 
questions from the attendees, Pam explored 
establishing new styles and redefining existing styles 
to suit personal taste. We also discovered the leader 
(also called fill tabs; the periods that often appear 
between text and its page in a TOC) can be added 
through the the Inspector with the Text and Tabs 
buttons pushed. Push the Text and Tabs buttons of the 
Inspector, select the tab stop of the page number in 
the list of Tab Stops, and use the Leader pop-up menu 
to select the type of leader you want. The leader 
magically appears in the TOC.

Your newsletter editor used what he learned at the 
SIG meeting to incorporate a TOC into this edition of 
the newsletter. It sure is nice to have the TOC 
generated automatically!

The next meeting is scheduled for Wednesday, August 
6 at 6:30 pm at the Augsburg Park Library. Hope to 
see you there!
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Q&A SIG of June, 2008
by Les Anderson

At the June Q&A meeting we reviewed the Web 
Options club members have to keep up-to-date on 
meetings and activities, as well as the Electronic 
Newsletter.

A little known web site is <homepage.mac.com/
miniapples>; this is where we archive public 
documents for the club, i.e., back issues of the 
eNewsletter and the club bylaws. They can be 
downloaded as PDF files.

The next source of information is the replacement for 
the club bulletin board service (BBS), <http://
miniapples.7.forumer.com/>. This is similar to the old 
BBS in that members can post questions, get the latest 
information on meetings, sell or buy items, and enter 
other discussion groups.

Finally, we have the mini’app’les general web site, 
<www.miniapples.org>. You can find the latest 
meeting changes and announcements here, as well as 
the latest eNewsletter for viewing or downloading. 
The club calendar is also here, and you can link it to 
the personal iCal calendar on your computer if you 
are using OS X. Be sure to have iCal automatically 
refresh.

One member 
asked how to print 
out his email 
address book. We 
struggled with this 
problem and as 
soon as I tried it at 
home I found the 
answer. It’s really 
quite simple, and 
you have a lot of 
options on what to 
print.

Start by launching 
the Address Book 
from the Dock. Do 
not use the address 

panel in Mail. Select the address to print from the 
Group on the left portion of the Address Book; if you 
don’t select All or a Group you print only one 
address. This is the problem we had. See Figure 1.

Next select Print from the File menu or use “Cmd P”. 
This brings up a Print Menu (see Figure 2). Make sure 
the Style pull-down menu is set to Lists. Using the 
Attributes on the lower right of the Print Menu win-
dow, select the data to print:  just the email addresses, 
just the phone numbers, or everything. You can even 
print mailing labels. The Preview option lets you see 
on your screen what the output looks like on paper.

Play around with it and you will find it quite useful.
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Strong Passwords
by Harry Lienke

I’m not aware of any computer guru named Strong 
who is selling Strong passwords so it is my intent to 
help you generate strong passwords yourself. 
Anywhere you can specify a password (for example, 
signing on to your Mac, signing on to a web site, or 
opening an encrypted disk image file [.dmg]), you 
should create a strong password to protect yourself 
from the hackers and identity thieves of the world 
(where you are allowed to create your own user name, 
it can act like a second strong password). These nasty 
folks are present in great numbers on the Internet 
looking to break into your accounts, and are also in 
your neighborhood looking to steal your data so they 
can steal your identity.

A strong password is one that is difficult for someone 
else to guess. In Mac OS X, Apple provides a 
Password Assistant that can be accessed to generate a 
strong password, but any password it generates is not 
likely to be very memorable. Your passwords should 
be based on something that is familiar to you but not 
likely to be known to other people; do not use things 
like your address, family birth dates and places, or 
family names that a stranger can easily learn. If you 
remember the acronym for the colors of the rainbow, 
one password could be based on “roygbiv”. Perhaps a 
particular line from literature is meaningful to you; “I 
think that I shall never see a poem as lovely as a tree” 
becomes “ittisnsapalaat” and “To be or not to be, that 
is the question” becomes “2bon2btitq”. Possibly the 
towns you pass on the way to the lake are Delano, 
Montrose, Waverly, Howard Lake, Cokato, Dassel, 
Darwin, Litchfield, Grove City, Atwater, and 
Kandiyohi, producing a password of 
“dmwhlcddlgcak”. Note that if the password must be 
shorter than these examples, you can select a portion 
of the larger password such as “ittisnsa” or 
“whlcddlgca”. Maybe your three favorite presidents 
are Franklin D. Roosevelt, Harry S. Truman, and 
Dwight D. Eisenhower; concatenate their initials and 
you get “fdrhstdde”. If two favorite literary characters 
of yours are Bryan and Jason, you can intertwine the 
names: bnroysaanj (jason is reversed). You can come 
up with thousands of combinations no one else is 
likely to guess.

To make your passwords stronger, add numbers or 
substitute numbers for letters. In the first example 
above, you can insert the number 7 (for seven colors) 
anywhere in the password: roy7g7biv or roygbiv7. 
You can substitute the number “0” (zero) for the letter 
“o” (oh) and substitute “4” for “iv” (4 in Roman 
numerals) to get r0y7g7b4. Other substitutions 
possible in other passwords include the number “2” 
for the words “to” or “too”, the number “3” for a 
letter “b” or a letter “e” (the 3 looks like a B or a 
backwards E), and the number “4” for the word “for”. 
Suppose the journey to the lake was 97 miles; you can 
add 97 to the shortened password “whlcddlgca” to get 
“whlcddlgca97”. Eisenhower was the 34th president 
of the United States so you can add this information 
into the password “fdrhstdde” to get “fdrhstd3d4e”. 
Make your password as long as permitted by the item 
which you are protecting; add characters and/or 
numbers to lengthen a password and chop off 
characters and/or numbers to shorten a password.

A password becomes much stronger if the item being 
protected recognizes the difference between upper 
and lower case characters; the number of possible 
combinations for a password increases greatly if you 
can use a lower case letter and an upper case letter as 
different symbols. The possibilities increase even 
more if passwords are allowed to contain special 
characters like @ (commercial at) and & 
(ampersand). You must check each item you are 
protecting to determine whether it recognizes upper 
and lower case and special characters. Unfortunately 
many web sites, possibly including one or more 
containing your financial information, do not 
distinguish between upper and lower case characters 
and do not permit special characters to be used. If you 
are not sure whether you can utilize both upper and 
lower case characters, enter a password containing 
both and then test the password by trying to sign in 
again using only upper case letters or only lower case 
letters; if you are allowed to access the item, the 
letters are not being recognized as both upper and 
lower case and you need not use both upper and lower 
case for future sign-ins. If it is not clear if the item 
you are protecting permits special characters to be 
used, try to establish a password with one or more 
special characters; if the password is not accepted, 
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you must re-enter the password without the special 
characters and accept the fact that the security level is 
lower than it could be.

It is important you use a different password for each 
item you need to protect. For example, use different 
passwords to get your email and to log in to a web 
site. If you use the same password in many places and 
a thief somehow obtains that password, all of your 
information is at risk even if you created a strong 
password.

After you have gone to the trouble of generating one 
or more strong passwords, you must avoid doing 
things that weaken the passwords.

To keep the password secret (and strong) you should 
not write the password down or send it in an email. 
Instead share the password with one or two trusted 
individuals whom you can contact easily. These folks 
should commit the password to memory and not write 
it down either!

If you must write it down because you are afraid you 
will forget it, follow these rules:

• Do not include any additional information that 
makes it easy to identify what the password is 
for.

• Store the paper away from your computer so no 
one else can access it easily; if possible, put the 
paper in a safe deposit box or entrust it to a 
friend or relative who lives some distance from 
you.

To keep multiple passwords safe, you can create an 
encrypted disk image file (.dmg) protected by a strong 
password and store your other passwords as text 
entries in that file. As long as a strong password is 
required to access the stored passwords, it is 
extremely unlikely that any bad guys will be able to 
break into your data. See the June, 2008, issue of this 
newsletter for instructions on creating that encrypted 
file. There are also shareware and commercial 
programs designed to help store passwords with a 
high degree of safety (see VersionTracker or 
MacUpdate to locate these programs).

Do not store your user names and passwords in the 
Keychain of your Mac. Chances are you leave your 
keychain unlocked when you are using your Mac; this 
exposes your secret information to people passing by 
your computer when you leave it for a few minutes. 
Putting your Mac to sleep and having a password 
protected screen saver will provide protection for 
your passwords, but having them stored in a separate 
file makes it much easier to transfer the passwords to 
your new or second computer.

Never, never, never enter a user name and password 
into a public computer at a place like a library or a 
hotel. Even if no one is looking over your shoulder, 
the computer may have a keystroke recording 
program running; this program records your 
information as you type it and then passes it on to 
some Internet thief who will use it to access your 
private information.

Putting a little effort into your password creation 
provides a lot of security for your private information.
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How to Protect Yourself from the New Mac 
OS X Trojans
by Rich Mogull 

[TidBITS Editor's note: this article initially 
recommended changing the permissions of 
ARDAgent to block the vulnerability, an approach 
that has been proposed by other sites as well. Our 
testing revealed that this approach may be 
insufficient, so we only recommend removing the 
ARDAgent as detailed below.]

One of the downsides of increased attention to 
computer security is that whenever a new 
vulnerability or attack technique appears, we, the 
humble users, face an onslaught of hyperbole from 
the press, security vendors, and bad guys themselves. 
This is especially true with Apple products, where we 
face the triple threat of security vendors trying to sell 
products to a disinterested community that usually 
doesn't need them, a press always eager to knock 
Apple down a notch, and bad guys looking to build 
their reputations at Apple's expense. In such a 
maelstrom of information it is often difficult for 
average users to separate the truth from the hype, 
evaluate their personal risk, and take defensive 
actions.

We watched this cycle kick into full gear during the 
past couple of weeks, starting with the announcement 
of a new Mac OS X vulnerability on 18-Jun-08 over 
at Slashdot. Soon after the unpatched vulnerability 
was disclosed the major Mac antivirus vendors 
updated their products and issued press releases to 
draw attention to the problem. It's an unfortunate truth 
that fear and bad news are effective sales tools for 
security products. By the next day, the first reports of 
this vulnerability being used in exploits appeared, 
followed by various news stories, additional alerts 
from security vendors, and new exploits from the bad 
guys. But what's the real risk to users?

The good news is, based on the nature of the 
vulnerability, the risk is low - but the bad news is that 
this kind of attack could become more serious. As 
usual, Apple will need to patch this one quickly.

This particular vulnerability is what we call "local 
privilege escalation." It enables a user of a system to 
escalate their rights to "root," which allows full 
control over the system. Thus, even if you are running 

as a regular user or in a guest account, exploiting this 
vulnerability allows you to escalate your rights to run 
without restriction. In this case, the Apple Remote 
Desktop agent (ARDAgent) uses a technique called 
SUID to run things as root. It's a common 
programming technique on Unix systems, but one that 
often creates security problems. In this case, 
ARDAgent supports AppleScript, including the 
command to run other programs, which then run as 
root. Simply running the AppleScript command

osascript -e 'tell app "ARDAgent" to do shell script 
"reallybadstuff"' 

runs "reallybadstuff" as root, without asking you for 
your password.

When this first appeared, I wasn't really worried. The 
attacker still needs to get you to run something on 
your system in the first place, and there are some 
simple things you can do to protect yourself (see 
Matasano Security's excellent blog post for more 
technical information and how to disable the attack). 
Privilege escalation attacks are typically used in two 
situations. The first is if someone has physical or 
remote access to your computer. He uses the attack to 
become root and install whatever software he wants, 
or otherwise messes around on your system.

The other scenario is more serious - the attacker 
exploits a vulnerability that gives them access to your 
user account, then he uses privilege escalation to take 
over your system as root, often installing additional 
malicious software. These combined attacks are 
common, although we don't see them often on Macs 
(in fact, I've never seen one on Mac OS X). The 
attacker will use something like a Web browser 
vulnerability to get his foot in the door, followed by 
the privilege escalation to, well, drive an invisible 
school bus into your house. We call that school bus a 
"Trojan horse" since, like the Trojan Horse, it 
conceals nasty stuff within a somewhat innocuous 
package.

In other words, Trojans aren't like viruses and worms. 
They don't break into your system, but they conceal a 
nasty payload that does something malicious once 
you execute them.

The first major Trojan to leverage the ARDAgent 
vulnerability is called "PokerStealer" (identified by 

mini’app’les Newsletter for August 2008 Page 9 of 11

http://db.tidbits.com/author/Rich%20Mogull
http://db.tidbits.com/author/Rich%20Mogull
http://it.slashdot.org/article.pl?sid=08/06/18/1919224
http://it.slashdot.org/article.pl?sid=08/06/18/1919224
http://it.slashdot.org/article.pl?sid=08/06/18/1919224
http://it.slashdot.org/article.pl?sid=08/06/18/1919224
http://it.slashdot.org/article.pl?sid=08/06/18/1919224
http://it.slashdot.org/article.pl?sid=08/06/18/1919224
http://www.matasano.com/log/1069/apple-ships-suids-with-applescript-dictionaries-hilarity-ensues/
http://www.matasano.com/log/1069/apple-ships-suids-with-applescript-dictionaries-hilarity-ensues/
http://en.wikipedia.org/wiki/Trojan_horse_(computing)
http://en.wikipedia.org/wiki/Trojan_horse_(computing)
http://www.intego.com/news/ism0803.asp
http://www.intego.com/news/ism0803.asp


antivirus vendor Intego). Rather than using some sort 
of attack to get on your system, it pretends to be a 
poker game. When it's run, it uses the ARDAgent 
vulnerability to escalate its rights (without asking for 
your password) and installs malicious software like a 
keystroke capture program.

A more serious problem is that, as reported by Brian 
Krebs at the Washington Post, some bad guys 
developed a tool to bundle a package of malicious 
software into any downloadable Mac application. It 
uses the ARDAgent vulnerability to run these pieces 
without your interaction, like PokerStealer. The 
program needs to run only once, then it embeds itself 
in your system. Interestingly enough, Krebs reports 
that this tool was in development since May 2008. We 
can expect the bad guys to use all sorts of social 
engineering tricks (like writing little games) to get us 
to run their software on our systems.

To protect yourself, if you don't use (or plan on using) 
Apple Remote Desktop (which is different from 
Screen Sharing), you can go to /System/Library/
CoreServices/RemoteManagement/ in the Finder, 
copy ARDAgent.app to your Desktop, right-click and 
compress it, and move the file someplace like your 
Documents folder. Then delete the original file. That 
way you just need to unzip and reinstall the file if you 
ever need ARDAgent down the road.

I almost avoided writing this story since I hate to add 
to the hype of low-risk threats like this. While I don't 
doubt for a second that we'll see serious Mac (and 
iPhone) security threats in the future, this one is low 
on the list of things to worry about, especially if you 
don't make a practice of downloading random 
software from unknown developers. But unlike many 
other Mac vulnerabilities, this one has already been 
weaponized and is starting to appear in the wild. It's 
clear the bad guys are slowly paying more attention to 
Mac OS X, although we've avoided any serious mass 
attacks so far. With all the hype, it's worth taking the 
time to raise our security awareness and understand 
the risks and how to protect ourselves without having 
to buy and maintain products that would likely 
provide only a false sense of security.

Unless otherwise noted, this article is copyright © 2008 Rich Mogull.
TidBITS is copyright © 2008 TidBITS Publishing Inc.
Reuse governed by Creative Commons License. 

Benefits of mini’app’les Membership

Access to the mini’app’les online forums. Post 
questions and/or answers about issues, trouble 
shooting, products, buying and selling, special events, 
discounts, and news about Apple and the mini’app’les 
club.

Access to our Members Helping Members network of 
professional and advanced users of Apple 
technologies. These members volunteer their time to 
help other members with software, hardware, and 
other Apple related issues.

A variety of Mac Special Interest Groups (SIGs) that 
meet each month.

Workshops to help members with computer problems. 
You can bring your equipment to these events and 
receive support from knowledgeable Mac users to 
help diagnose your problem(s).

Participation in drawings for computer hardware, 
software, and other computer related materials.

Discounts from vendors and manufacturers.
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Membership Application and Renewal Form

Name:     

Company (if mailed to):     

Address:     

     

City, State, Zip:     

Phone # (home):     

Phone # (work):     

Phone # (cell):     

Occupation (if applicable):     

Membership ID # (if renewal):     

Email:     

   Your e-mail address will NOT be sold, shared or distributed. It will be used to notify you of the availability of 
a new issue of the newsletter.

   Check if this is a change of address notice

   Check if you want to volunteer

   Check if you want to be added to “Members Helping Members”

   Check if you were referred by a club member (if so, please give member’s name)

Membership cost is $15.00 for one year. Please make your check payable to “mini’app’les”.

Please send this application and your payment to:
mini’app’les
P.O. Box 796
Hopkins, MN 55343-0796

Thank you for your support!
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